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Preface 

Introducing the Relativity DBA 
The Relativity DBA (Database Administrator) is an interactive, Windows-based tool that 
enables the System Administrator at the end user location to maintain and manage the 
Relativity database and the security of the Relativity database. 

The Relativity DBA provides the following functions: 

• Defines and authorizes users of a Relativity database. 

• Restricts the view of the data for individual groups of users. 

• Maintains the linkages, known as table connections, between table definitions and 
physical COBOL data files. 

• Manages date constants. 

• Merges security and table connection information into a new catalog (an optional 
function controlled by the catalog developer). 

• Produces reports on security and connections. 

This manual, the Relativity DBA Installation Guide, which is part of the Relativity document 
set listed in Related Relativity Documentation (on page 1), describes how to install the 
Relativity DBA software component and verify that the installation was successful. 

In addition, your Relativity package contains the document, The Theory of Relativity, A 
Primer, which defines specific terminology and provides a comprehensive overview of the 
Relativity software tools and their functions.  Before you install this Relativity product, be 
sure to read this book. 

Related Relativity Documentation 
In addition to the Relativity DBA Installation Guide and The Theory of Relativity, A Primer, 
the Relativity documentation set consists of the following items: 

• Relativity Client/Server Installation Guide.  A document (one for UNIX and one for 
Windows) that is intended for a System Administrator.  It describes the following: 

− How to install the Relativity Data Server software component on a computer running 
either a UNIX or Windows operating system and verify that the installation was 
successful. 
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− How to: 

• Install the Relativity Data Client software component on a secure Windows 
workstation (such as the workstation belonging to a Database Administrator) for 
the purpose of catalog development. 

• Install the Relativity Server Administrator utility program in order define a 
server for the client and configure a server data source. 

• Verify communications between the client and the server. 

− How to install the Relativity Data Client software component on an end user’s 
Windows workstation and verify that the installation was successful by configuring a 
client data source and associating it with a server data source. 

− How to run the RM/COBOL Indexed File Recovery utility (recover1) to recover an 
RM/COBOL indexed file. 

• Relativity Data Client for UNIX Installation Guide.  A document that describes how 
to install and verify the Relativity Data Client software component on a UNIX-based 
server or workstation.  It also describes the utilities for creating client and server data 
sources. 

• UNIX Driver Managers Build Guides.  A pair of HTML documents, located in the 
UDrvMan directory of the Relativity Data Client for UNIX Electronic Software Delivery 
download file and on the Relativity Data Server product CD, that give instructions on 
how to build the two ODBC Driver Managers for UNIX (unixODBC and iODBC) on the 
various UNIX platforms that the Relativity Data Client for UNIX supports.  Note that 
these documents should be referenced only if you decide to rebuild the Liant-supplied 
versions of these Driver Managers. 

• Relativity Data Manager Installation Guide.  A document that describes how to install 
the Relativity Data Manager software component on a Windows-based workstation and 
verify that the installation was successful. 

• Relativity Designer Installation Guide.  A document that describes how to install the 
Relativity Designer software component and verify that the installation was successful. 

• Relativity Java Client User’s Guide.  An HTML document, located in the JDBC 
directory of the Relativity Java Client Electronic Software Delivery download file and on 
the Relativity product CD, that describes the installation and verification of the Relativity 
Java Client as well as information about deploying it with Java applications and applets, 
and setting up data source connections.  The Java Client is a Java Database Connectivity 
(JDBC) component that resides in a Java runtime environment (JRE). 

• Relativity Online Help.  An online HTML help documentation system that provides fast 
access to detailed information on Relativity features and options.  The help system also 
contains step-by-step presentations on how to accomplish specific tasks with Relativity 
and an extensive glossary.  A separate help file is provided for each of the various 
Relativity tools:  the DBMS (Data Client and Data Manager), the Designer, the DBA, the 
Relativity Configuration Utility, and the Server Administrator.  For more details, see 
Using Online Help (on page 3). 

• Relativity README Files.  A set of online HTML documents that lists any changes to 
the Relativity documentation since its publication and contains new technical information 
that supplements the documentation. 

• LiantInstall Program User’s Reference.  A document that describes how to configure 
and control the installations of Liant products, including Relativity. 
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Using Online Help 
The Relativity DBA comes with extensive online assistance and step-by-step instructions.  
You can access DBA Help while using Relativity in a number of ways.  The method you use 
often depends on the type of information for which you are searching. 

• Help Contents.  In the Relativity DBA main window, from the Help menu, click 
Contents to open the Relativity DBA online HTML Help system.  The left side of the 
Help window (the navigational pane) contains the Contents, Index, Search, and 
Favorites tabs.  The right side of the Help window (the topic pane) displays the currently 
selected Help topic.  Across the top of the Help window is a group of buttons that help 
you navigate through the Help contents and perform other operations, such as printing a 
topic in the Help file. 

− To browse through topics grouped by subject:  Click the Contents tab.  From 
here, you can go directly to more specific information and a list of all the Help topics 
by double-clicking any closed book icon.  Then select the topic of interest from the 
expanded list and click the topic.  The Help window for that topic appears in the 
topic pane. 

− To see a list of alphabetized index entries (or keywords):  Click the Index tab to 
find specific topics listed alphabetically (the online index is arranged just like a book 
index).  Type an entry or the first few letters of the word you want to search for, or 
scroll through the list.  Then select the topic and click the Display command button.  
The content of the Help topic opens in the Help window. 

− To search for words or phrases that may be contained in a Help topic:  Click the 
Search tab.  Follow the instructions on your screen to complete this task. 

− To create a list of preferred Help topics:  Click the Favorites tab.  Follow the 
instructions on your screen to complete this task.  Note that, by default, the contents 
of this tab is empty until you select topics to populate it.  The content of the 
Favorites tab is automatically saved between sessions. 

• Context-sensitive Help.  While you are working in Relativity, you also can press F1 to 
access the associated Help topic for currently selected menu commands, toolbar buttons, 
dialog box options, and other screen elements. 

• Tool tips.  When you pause with the pointer (without the mouse button pressed) over an 
item on a toolbar, a small pop-up window that includes a brief description is displayed. 

• Help button in a dialog box.  If available, click the Help button in the dialog box you 
are using.  A Help topic explaining the dialog box appears. 

You can exit Relativity online Help from the Help window by clicking the Close button on 
the title bar or double-clicking the Control Menu icon at the left end of the title bar.  To exit 
a context-sensitive Help window, if necessary, press the Esc key on the keyboard. 

From the Relativity DBA Help menu, you can also access additional online Help files: 

• Click DBMS Help File for information on using the Relativity Data Manager. 

• Click Server Admin Help File for information on using the Relativity Server 
Administrator. 

• Click Relativity Configuration Help for information on using the Relativity 
Configuration Utility to set options that apply to all Relativity data sources. 
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Conventions Used in this Document 
This document contains visual cues to help the reader identify important information. 

Table Convention Indicates 

Initial Capitals Menu names, command names, and dialog box, window, and form 
titles. 

Bold Menu, command, and button names. 
Other elements to be selected or typed to accomplish an action. 
Label on input media used during installation. 

Italic Reference to a topic in the current document or another Relativity 
document. 
Reference to another document. 
Emphasis. 

Bold Italic Variables. 

Registration 
Please take a moment and register your Liant product online at:  http://www.liant.com. 

Registering your product entitles you to the following benefits: 

• Customer support.  Free 30-day telephone support, including direct access to support 
personnel and 24-hour message service. 

• Special upgrades.  Free media updates and upgrades within 60 days of purchase. 

• Product information.  Notification of upgrades or revisions to Relativity when they are 
released. 

You can also receive up-to-date information about Liant and all its products via our web site.  
Check back often for updated content. 

Technical Support 
Liant Software Corporation is dedicated to helping you achieve the highest possible 
performance from the Liant family of products.  The technical support staff is committed to 
providing you prompt and professional service when you have problems or questions about 
your Liant products. 

Technical support services are subject to Liant’s prices, terms, and conditions in place at the 
time the service is requested. 

While it is not possible to maintain and support specific releases of all software indefinitely, 
we offer priority support for the most current release of each product.  For customers who 
elect not to upgrade to the most current release of the products, support is provided on a 
limited basis, as time and resources allow. 

http://www.liant.com/
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Support Guidelines 
When you need assistance, you can expedite your call by having the following information 
available for the technical support representative: 

• Company name and contact information. 

• Liant product serial number (found in the Electronic Software Delivery email, on the 
media label, or in the product banner message). 

• Liant product version number. 

• Operating system and version number. 

• Hardware, related equipment, and terminal type. 

• Exact message appearing on screen. 

• Concise explanation of the problem and process involved when the problem occurred. 

Test Cases 
You may be asked for an example (test case) of the source that demonstrates the problem. 

• The smaller the test case is, the faster we will be able to isolate the cause of the problem. 

• Do not send full applications. 

• Reduce the test case to the smallest possible combination of components required to 
reproduce the problem. 

• If you have very large data files, write a small program to read in your current data files 
and to create new data files with as few records as necessary to reproduce the problem. 

• Test the test case before sending it to us to ensure that you have included all the 
necessary components to run the test case. 

When submitting your test case, please include the following items: 

1. README text file that explains the problems.  This file must include information 
regarding the hardware, operating system, and versions of all relevant software (including 
the operating system and all Liant products).  It must also include step-by-step 
instructions to reproduce the behavior. 

2. Program source files.  We require source for any program that is called during the 
course of the test case.  Be sure to include any copy files necessary for recompilation. 

3. Data files required by the programs.  These files should be as small as possible to 
reproduce the problem described in the test case. 
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Chapter 1:  Installation 

This chapter lists the system requirements and describes how to install the Relativity DBA 
software program on a Microsoft Windows operating system.  Procedures for removing the 
Relativity DBA (see page 11), if necessary, are also provided. 

System Requirements 
Installation of the Relativity DBA on a Windows-based workstation for application 
development requires the following minimum software and hardware. 

Component Requirement 

Computer An IBM PC or compatible machine with a Pentium-class processor or 
higher. 

Operating System Microsoft Windows 2000, Windows XP, Windows Server 2003, 
Windows Vista, or Windows Server 2008. 

Memory 64 MB is recommended. 

Disk Space A hard drive with at least 11 MB of free disk space. 

Installation Media Internet access and/or one CD-ROM drive and one 3.5” diskette drive. 

Monitor 800 x 600 resolution is required.  Higher resolution is recommended. 

Internet Browser A browser (for example, Mozilla Firefox or Microsoft Internet Explorer) 
capable of viewing HTML files, such as the README text or other 
documents that are available in this format. 

Adobe Reader This software, available free from Adobe.com, allows you to view (and 
print) the Portable Document Format (PDF) documents. 

Note  Relativity no longer supports earlier Microsoft Windows versions, including  
Microsoft Windows 98, Microsoft Windows 98 SE, Microsoft Windows Me, and Microsoft 
Windows NT 4.0. 
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Installing the Relativity DBA 
Note  If you have a previous version of Relativity installed, you should remove it prior to 
installing a newer version.  See Removing the Relativity DBA (on page 11). 

The Relativity DBA can be installed on a Windows workstation using the following methods: 

• Electronic Software Delivery Installation (as described below) 

• CD-ROM Installation (see page 10) 

You may also automate the installation program for the Relativity DBA, which allows the 
installation of the DBA to be incorporated with the installation of your application.  For more 
information, navigate to www.liant.com/docs.html and refer to the “Relativity DBA 
Installation Details” section of the LiantInstall Program User's Reference documentation. 

To verify that the installation is successful, see Chapter 2:  Verification (on page 13). 

Note  The instructions that follow refer to an installation components directory, which is the 
directory to which the deliverable file via electronic software delivery was downloaded and 
decompressed. 

Electronic Software Delivery Installation 
Note  You must have an Internet connection and an Internet browser installed to proceed with 
this method of installation. 

The email containing notification of your Electronic Software Delivery contains an 
attachment, a file named liant.lic.  This file is a license certificate authorizing you to install 
the purchased software.  We recommend that you create a directory on your machine to store 
the license certificates for your Liant products and save the liant.lic attachment to this 
directory with a name that is meaningful to you. 

The Relativity DBA is available as a download from the Liant Electronic Software Delivery 
web site in two formats:  Windows Self-Extracting EXE and ISO CD Image.  From the web 
site, simply follow the download and decompress instructions for the file format selected, and 
then perform the installation instructions for that format, as outlined below. 

• Windows Self-Extracting EXE.  The download format for Windows Self-Extracting 
EXE contains only the Relativity DBA product.  After downloading and decompressing 
the deliverable, and creating the installation components directory from the Windows 
Self-Extracting EXE format, follow these steps to install the Relativity DBA software: 

Note  When the Windows Self-Extracting EXE is decompressed and the installation 
components directory is created, the LiantInstall program should start automatically.  If 
this is the case, proceed to step 6.  Otherwise, begin with step 1. 

1. Place a copy of your Relativity DBA license certificate, liant.lic, in the directory 
containing the installation components. 

2. Click Start, and then click Run.  In the Run dialog box, click the Browse button. 

3. In the Browse dialog box, navigate to the directory containing the installation 
components. 

4. Click on the file, LiantInstall, and then click Open. 

5. In the Run dialog box, click OK. 

www.liant.com/docs.html
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6. The LiantInstall program begins executing.  Follow the instructions presented on 
the screen and press the Next button to advance through the various pages. 

7. On the Software License Agreement page, you must click “I accept the terms in the 
license agreement” in order to continue with the installation. 

8. On the License Certificates page, the license certificate file for the product being 
installed is displayed.  Do one of the following: 

• If the license certificate for the Relativity DBA software being installed is 
present in the list area, press the Next button. 

• If the license certificate for the Relativity DBA software being installed is not 
present in the list area: 

a. Press the Add button. 

b. In the Select License Certificates dialog box, navigate to the directory 
containing the license certificate file for the Relativity DBA software being 
installed and select the filename for the license certificate.  (This license 
file, named liant.lic, is attached to the original electronic software delivery 
email for the product.) 

c. Press the Open button and then press Next. 

9. On the Installation Type page, do one of the following: 

• Select the “Standard Installation” option to install all the components of all the 
license certificates listed on the License Certificates page immediately, using 
their default settings.  Press the Install button. 

• Select the “Custom Installation” option to select specific components (for those 
products with multiple components) of all the license certificates listed on the 
License Certificates page, and install them, changing their default installation 
settings, as necessary. 

Follow the custom installation instructions presented on the remaining pages.  
On the Ready to Begin Installations page, press the Install button. 

When the installation for the Relativity DBA program starts, follow the 
additional instructions presented by the installation program. 

10. When either the standard or custom installation is complete, click the Finished 
button on the Installation Status page. 

• ISO CD Image.  The download format for ISO CD Image contains the full Relativity 
product CD, including the Relativity DBA and the other Relativity products.  Use  
CD-ROM Burning software, such as Nero (http://www.nero.com) or Roxio’s Easy CD 
Creator (http://www.roxio.com), to create the physical CD-ROM media and then follow 
the instructions contained in CD-ROM Installation (on page 10) to install your product. 
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CD-ROM Installation 
After downloading and decompressing the deliverables, and creating the installation 
components directory from the ISO CD Image format, follow these steps to install the 
Relativity DBA software from the CD-ROM: 

1. Insert the product CD in the appropriate CD-ROM drive. 

2. Do one of the following: 

• If the installation program starts automatically, proceed to Step 3. 

• If the installation program does not start automatically, click Start, and then click 
Run.  In the Open text box of the Run dialog box, type the following: 

d:LiantInstall 

where, d is the drive letter of the CD-ROM drive.  Click OK. 

3. The LiantInstall program begins executing.  Follow the instructions presented on the 
screen and press the Next button to advance through the various pages. 

4. On the Software License Agreement page, you must click “I accept the terms in the 
license agreement” in order to continue with the installation. 

5. On the License Certificates page, the license certificate file for the product being installed 
is displayed.  Do one of the following: 

• If the license certificate for the Relativity DBA software being installed is present in 
the list area, press the Next button. 

• If license certificates for any products you do not wish to install are present in the list 
area, select them and press the Remove button.  Then, press the Next button. 

• If the license certificate for the Relativity DBA software being installed is not 
present in the list area: 

a. Press the Add button. 

b. In the Select License Certificates dialog box, navigate to the directory 
containing the license certificate file for the Relativity DBA and select the 
filename for the license certificate. 

This license file, usually named liant.lic, is included on the license diskette that 
came as part of the installation media. 

c. Press the Open button and then press Next. 

Note  The liant.lic license certificate file can be copied from the diskette to a 
location on a hard drive and that location can be specified during installation.  We 
recommend that you create a separate directory on your machine to store the license 
certificate files for all your Liant products and save those files with a name that is 
meaningful to you. 

• If there are license certificates for any other products that you wish to install at this 
time, press the Add button again to add them; otherwise, press the Next button. 
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6. On the Installation Type page, do one of the following: 

• Select the “Standard Installation” option to install all the components of all the 
license certificates listed on the License Certificates page immediately, using their 
default settings.  Press the Install button. 

• Select the “Custom Installation” option to select specific components (for those 
products with multiple components) of all the license certificates listed on the 
License Certificates page, and install them, changing their default installation 
settings, as necessary. 

Follow the custom installation instructions presented on the remaining pages.  On the 
Ready to Begin Installations page, press the Install button. 

When the installation for the Relativity DBA program starts, follow the additional 
instructions presented by the installation program. 

7. When either the standard or custom installation is complete, click the Finished button on 
the Installation Status page. 

Removing the Relativity DBA 
The Relativity DBA can be removed from the Windows workstation on which it was 
installed.  This may be necessary if the Relativity DBA is to be moved to a different machine 
or if a new release of the Relativity DBA is to be installed on the same machine. 

To remove the Relativity DBA: 

1. Open the Windows Control Panel. 

2. In the Control Panel, do one of the following: 

• On Windows 2000, XP, or Server 2003, double-click Add or Remove Programs. 

• On Windows Vista or Server 2008, double-click Programs and Features. 

3. In either the Add or Remove Programs window or the Programs and Features window, 
select Liant Relativity vx DBA from the list of currently installed programs and updates.  
(vx is the version number of the product to be removed.) 

4. Do one of the following to start the uninstall process: 

• On Windows 2000, XP, or Server 2003, click the Remove button. 

• On Windows Vista or Server 2008, click the Uninstall button. 

5. In the message box, click Yes to proceed with the uninstall process. 

6. The Liant Relativity vx DBA dialog box is then displayed, detailing the progress of  
the uninstall. 

When the uninstall is successfully completed, click OK. 

7. Click OK to close either the Add or Remove Programs window or the Programs and 
Features window. 

8. Close the Windows Control Panel. 
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Chapter 2:  Verification 

This chapter describes how to verify the installation of the Relativity DBA software on a 
Windows-based workstation.  The verification takes place with a catalog that was installed 
during the installation of the Relativity Data Manager or Relativity Data Server, and a data 
source named Verify that was created during the verification of the installation of the 
Relativity Data Manager or Relativity Data Server and Data Client products. 

Methodology 
The Relativity DBA is used by the System Administrator to maintain the linkages between 
table definitions and physical COBOL files. 

If the Relativity DBA has been properly installed, you will be able to view the existing table 
connection for the BackOrder table in the sample Verify database. 

Relativity must know the physical access name information for the COBOL file that contains 
the actual data.  The table connection consists of two important items: 

• The path name (that is, the physical filename) of a COBOL data file. 

• The table name by which SQL statements can reference the data in the file. 

Relativity distinguishes between the name of a table definition and the actual SQL table name.  
Physical files that share the same COBOL file definition may be described by one Relativity 
table definition.  The table name within the table connection is what an ODBC-enabled 
application actually “perceives” as a relational table. 

Prerequisites 
This verification process assumes the following: 

• If you are using the client/server version of Relativity, that you have followed the 
instructions in the Relativity Client/Server Installation Guide (for either UNIX or 
Windows, as appropriate) to install a Relativity Data Server, set up a server data source 
named Verify, install a Relativity Data Client on the same machine as the Relativity 
DBA, and set up a client data source that is also named Verify and associate it with the 
server data source, Verify. 
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• If you are using the single-tier (that is, non-client/server) version of Relativity, that you 
have installed a Relativity Data Manager on the same machine as the Relativity DBA and 
followed the instructions in the Relativity Data Manager Installation Guide for setting up 
a data source named Verify. 

Starting the Relativity DBA 
To start the Relativity DBA in Windows: 

1. Click Start, point to Programs, point to Liant, point to Relativity vx (where vx is the 
version number of the product), and then click DBA. 

The Welcome to Relativity window is displayed and you are ready to open the Verify 
data source. 

 

Note  The Welcome to Relativity window appears when you first install and start the 
Relativity DBA.  From this window, you can set up and create a new data source, or open 
an existing or recently used Relativity data source.  After completing the first session 
with Relativity, the most recently used data source is always selected by default in this 
window when you start Relativity again.  To disable the Welcome to Relativity window 
after the initial installation, clear the Show Welcome at Startup check box.  Subsequently, 
when you start another Relativity session, you will begin all operations in the Relativity 
DBA main window.  You may, however, enable this capability again by choosing 
Welcome from the Tools menu. 

2. If you wish, click Cancel to dismiss the Welcome to Relativity window. 
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Opening a Data Source 
To open the Verify data source: 

1. In the Relativity DBA main window, on the File menu, click Open Data Source. 

The Open Relativity Data Source dialog box opens. 

 

Alternatively, if the Welcome to Relativity window remains displayed, click either the 
Recent or Exisiting option, select the Verify data source from the list, and then click 
OK.  Proceed to Step 3. 

2. In the Data Source Name box, select Verify.  If necessary, click the Down Arrow to 
display a list of data source names. 

3. Click Open. 

The Logon dialog box opens to collect information needed in order to authenticate your 
access to the server. 

 

4. In the Logon dialog box, type a user name in the appropriate box and click OK.  
(Because security has not been set up to access the Verify data source, any user name will 
suffice and no password is required.) 
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The Catalog window for the selected data source, Verify, is displayed in the Relativity 
DBA main window. 

 

Viewing a Table Connection 
1. In the Relativity DBA main window, on the Edit menu, click Connections. 

The Edit Connections form is displayed. 
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Alternatively, select the table name on the Tables tab in the Catalog window and click the 
Connections button.  When you use this method, the table definition is already expanded 
to display the table connection in the Edit Connections form, as described in Step 2. 

2. In the Edit Connections form, expand the table definition and display the table connection 
associated with the table definition: 

a. Click the plus sign [+] preceding the table definition to display the table name, 
BackOrder. 

b. Click the plus sign preceding the table name to display the path name, PROD2FIL. 

 

The Edit Connections form shows the existing table connection (that is, the table name and 
the path name) for the BackOrder table, which indicates that the Relativity DBA has been 
installed correctly. 
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Closing the Data Source 
To close a data source, do one of the following: 

• On the File menu, click Close Data Source.  Shortcut:  Ctrl+D. 

• In the Catalog window, click Close in the upper-right corner of the title bar. 

When you close a data source, the Relativity DBA main window remains open, allowing you 
to reopen the data source, open another data source, or exit the Relativity DBA. 

Exiting the Relativity DBA 
To exit the Relativity DBA, do one of the following: 

• On the File menu, click Exit.  Shortcut:  Ctrl+F4. 

• In the Relativity DBA main window, click Close in the upper-right corner of the title bar. 
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